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1 Introduction to OVAE NRS 

1.1 Purpose 

This document was created to provide NRS state users with a set of instructions on the functionality 

of the Division of Adult Education and Literacy (DAEL) National Reporting System (NRS) 

application. 

1.2 Access 

The following is a listing of the user groups and their roles when accessing the OVAE NRS 

application: 

System Administrator – Manages user accounts; manages agency accounts; approves/rejects 

data submission; ensures data integrity; views, edits, uploads and prints data. 

State Administrator –Views, edits, uploads and prints state data. 

State User – Views, edits, uploads and prints data relative to their respective state. 

Public User – Views and prints data. 

Federal User – Approves/Rejects Documents accessing “Review and Approve Documents” 

link on the Admin page. Views and prints data and reports for all states. 

 

1.3 Overview 

The Workforce Investment Act, among a variety of other legislation, requires a means for 

measuring the effectiveness of adult education programs. OVAE established the NRS for Adult 

Education for exactly that purpose. 

The OVAE NRS application is a central database repository of data collected for national reporting 

purposes.  Users can view data and generate reports on nationwide and statewide vocational and 

adult education statistics. 

For OVAE NRS program and reporting guidelines information, log onto http://www.nrsweb.org/. 

  

http://www.nrsweb.org/
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2 GETTING STARTED 

OVAE NRS has been tested using Internet Explorer 7. JavaScript must be enabled for the application to 

work properly. Please follow the below instructions to enable JavaScript in Internet Explorer 7. These 

steps may differ for other browsers. 

 

1. Select Tools > Internet Options 

2. Select Security tab 

3. Select Custom Level button 

4. Scroll down to Scripting section 

5. Select to enable Active Scripting 

6. Select OK button 

7. Select OK button to close Internet Options 

2.1 Login 

To access the OVAE NRS login screen, open your Internet browser to 

http://wdcrobcolp01.ed.gov/CFAPPS/OVAE/NRS 

The OVA NRS login screen appears. (Figure 1). 

 
Figure 1.  OVAE NRS Login Screen 

 

http://wdcrobcolp01.ed.gov/CFAPPS/OVAE/NRS
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Follow these steps: 

1. Enter your email address and password in the appropriate fields. 

2. Click the Login button. 

3. The OVAE NRS user interface opens. 

 

Note: If you cannot remember your password, click the Forgot Password button.  An email will be sent to 

your registered email account with your password information.  

2.2 Password Management 

For security purposes, all passwords for NRS user accounts are subject to the following guidelines 

1. Passwords more than 90 days old must be changed after the next login. The user cannot access 

any part of the NRS application until the password has been changed. 

2. New passwords must meet the following guidelines for content: 

a. A minimum of eight characters. 

b. Elements of at least 3 of the following character groups: 

i. Uppercase letters 

ii. Lowercase letters 

iii. Numbers 

iv. Non-alphanumeric characters 

c. Cannot be the same as any of the last 5 stored passwords 

3. For all users except System Administrators, passwords cannot be changed more than once in a 

24-hour period. A system Administrator may change a user’s password as many times as 

needed. 

 

2.3 Forgot Password 

If a user forgets their password, they should enter their email address in the Email field on the OVAE 

NRS Login screen and click the Forgot Password button. A temporary password will be created and sent 

to the email address associated with the account. Upon logging in with the temporary password, the user 

must change their password before gaining access to any other section of the NRS application. 

Once the Forgot Password feature has been utilized for an account, the pre-existing password for that 

account will not be valid anymore. The temporary password must be used. 
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2.4 OVAE NRS User Interface 

2.4.1 OVAE NRS Home Page 

The OVAE NRS application has been divided into four sections.  The home page includes a display 

by title link for the three:  (1) Statistical Section, (2) Financial Section, (3) Narrative section and (4) 

Guidelines section.  To access a section, simply click on the link. 

 

Figure 2.   OVAE NRS Home Page 

 

The OVAE NRS user interface includes two (2) main components: 

2.4.2    OVAE NRS Banner 

The OVAE NRS Banner (Figure 3) includes account management tools for the user. 

 

                     

 

Figure 3.  Sample OVAE NRS Banner 

The banner options allow the user to view or edit account information; to change the access 

password; and to log out of the system.  An online version of this State User Guide may be 

accessed by clicking the Help & FAQs link at any time. 

2.4.3 OVAE NRS Header 

The OVAE NRS Header can be broken down into two parts: 

Part 1 consists of three (2) drop-down menus (see Figure 4) whose chosen values will serve 

as criteria for data output, as described in full detail within the following section, Section 

3.1, Data Selection Criteria 
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In the Narrative section, the header will not contain the third drop-down menu (for Select 

Table), as there is only one narrative report per state and program year. 

This portion of the header will not be shown in other sections. 

 

 

Figure 4.  Data Selection Criteria 

Part 2 consists of a tabs menu (see Figure 5), consisting of four (4) tabs: Tables, 

Documents, Performance, and Reports.  

 

     

Figure 5.  Tabs Menu 

 

Note: An added feature of the OVAE Header is that upon clicking on any of the menu tabs, the 

background color of the header will change to correspond to the color of the selected tab.  

This color feature serves as a reminder to the user of the menu tab that he/she has chosen to 

work with. 
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3 VIEWING STATISTICAL TABLE DATA 

3.1 Data Selection Criteria 

The selection criteria required for the viewing of table data includes the selection of a: 

 Program Year 

 Table Number 

 

Table data can be viewed by choosing values for the data selection criteria, then clicking the Go 

button. 

Note: Clicking on a table link, as opposed to choosing values for the data selection criteria and then clicking 

the Go button, will always display table data retrieved from the PREVIOUS data selection criteria 

process. 

 

 

Figure 6.  Sample Table Listing 
 

4 MANIPULATING STATISTICAL TABLE DATA 

Within the OVAE NRS Header, lies a Tabs Menu (see Error! Reference source not found.) for use in 

manipulating table data.  The tabs menu is conveniently defaulted to the Tables tab, providing a listing of 

table titles for the user to choose from while defining selection criteria. 

4.1 Tables Tab 

Clicking on the Tables tab will allow the user to view, print, and/or manipulate table data.  A 

listing, by table number, is provided for user selection. 

4.1.1    Table Status Indicators 

A color-coded indicator is used to indicate the current status of all tables included in the 

listing. 
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- Approved –
   

          an indication that the information that was submitted has been 

validated, approved, and the table locked by the system administrator.  To edit 

approved data, contact the System Administrator to unlock the table. 

- In Progress –  an indication that although information has been entered and 

saved, it has not yet been submitted. 

- Awaiting Approval –   an indication that information has been submitted, awaits 

approval, and that the table has been locked by the system administrator.  To edit data 

awaiting approval, contact the System Administrator to unlock the table. 

- Rejected (Errors Present) –   an indication that the information contained 

within the table submitted was rejected by the system administrator and, subsequently, 

an email was automatically generated and sent to the state administrator notifying 

him/her of such. 

4.1.2 Table “Action” Options 

Several actions may be performed on table data.  Action options are available based on 

table status, as defined in Section 4.1.1,    Table Status Indicators above.  (Circled in 

Figure 7). 

 

Figure 7.  Table Action Options 

 

Action options include the following: 

- Edit – Allows the user to edit table data.  When editing table data, no commas may be 

entered.  For values that equate to Not Applicable or None, “N/A” or “0” MUST be 

entered into the field – no field may be left blank.  Data should be saved periodically.  

In particular, data MUST be saved before accessing other header tabs, and in instances 

where your system is expected to remain idle for longer than twenty minutes.  Failure 

to save your data will result in a loss of your edits.  Clicking the Submit button commits 

the data for approval by the system administrator. 

In the event of a Warnings Present message, data may be saved, but NOT submitted.  

The data should be edited to address the specific warnings.  Upon completion, clicking 

the Submit button commits the data for approval by the system administrator.   
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In the event of an ERROR message, data may NOT be saved nor submitted.  The data 

should be checked for accuracy, and corrections to errors found should be made.  

Failure to correct errors before leaving the page will result in a loss of data/input. 

The Edit Table option is NOT available when a table’s status is Awaiting Approval or 

Approved.  At this point, the table is “locked”.  To have a table “unlocked” for editing, 

contact the System Administrator. 

Note that when a user is editing a table for a particular state and year, the system will 

NOT prevent any other user (State User or State Administrator) from editing that table. 

If a user is unable to edit data because it is locked, the system will display a message 

(Figure 8) indicating that another user is editing the table and to try again later. To have 

a table “unlocked” for editing, click on the Unlock This Table button. 

 

Figure 8. Table Lock Message 

 

- Upload – Allows the user to upload a comma separated values (CSV) file containing 

table data, to be submitted for subsequent approval and commission to the data 

repository.   The required format for the CSV file is very specific and must be followed 

to the letter.  See Appendix A for instructions on how to create a CSV file and for file 

format examples. 

From the Upload Table interface, enter the file path and name in the field labeled File; 

or click on the Browse button to locate the CSV file on your computer.  Once the file 

path and name has been inserted onto the interface, click the Upload button to upload 

the table data.  NOTE:  Regardless of the year that the user interface is set on, the table 

data will be uploaded to the year specified in the CSV upload file. 

At this point, you will be redirected to the Edit Table interface, where you must check 

the data for accuracy, make any changes, and/or correct any errors found.  Clicking the 

Submit button commits the data for approval by the system administrator.  Remember, 

when editing table data, no commas may be entered.  For values that equate to Not 

Applicable or None, “N/A” or “0” MUST be entered into the field – No field may be 

left blank. 

 Also, data should be saved periodically.  In particular, data MUST be saved before 

accessing other header tabs and in the case where your system is expected to remain 

idle for longer than twenty minutes. Failure to save your data will result in a loss of 

your edits.    

 Note that when a user is uploading data to a table for a particular state and year, the 

system will prevent any other user from uploading data to that table until the first user 

has finished uploading. If a user is unable to upload data because it is locked, the 

system will display a message indicating that another user is editing the table and to try 
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again later. To have a table “unlocked” for uploading, contact the System 

Administrator. 

- View* – Allows the user the single option of viewing the data. 

- Print *– Allows the user to output data to the screen at which time the user can then 

choose File, Print from their browser menu to output the data to a connected printer.  

Note:  Printer properties may, or may not, need to be adjusted to “landscape” when 

printing. 

*Note:  To protect the confidentiality of U.S. Department of Education data and tabulations 

containing information about individuals, while viewing or printing OVAE NRS data, table 

and report values (with the exception of monetary figures and percentages) from 1 to 5 will 

be suppressed and indicated by a “+”.  Also, the value of the total of any column or row 

will be suppressed if the column or row contains a suppressed value. 

5 VIEWING FINANCIAL TABLE DATA 

5.1 Data Selection Criteria 

The selection criteria required for the viewing of table data includes the selection of a: 

 State 

 Program Year 

 Table Number 

 

 

Table data can be viewed by choosing values for the data selection criteria, then clicking the Go 

button. 

Note: Clicking on a table link (see Figure 9), as opposed to choosing values for the data selection criteria and 

then clicking the Go button, will always display table data retrieved from the PREVIOUS data 

selection criteria process. 

 

 

Figure 9.  Sample Table Listing 
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6 MANIPULATING FINANCIAL TABLE DATA 

 

Within the OVAE NRS Header lies a Tabs Menu (shown in Figure 5) for use in manipulating table data.  

The tabs menu is conveniently defaulted to the Tables tab, providing a listing of table titles for the user to 

choose from when defining selection criteria. 

6.1 Tables Tab 

Clicking on the Tables tab will allow the user to view, print, and/or manipulate table data.  A 

listing, by table number, is provided for user selection. 

6.1.1 Table Status Indicators 

A color-coded indicator is used to indicate the current status of all tables included in the 

listing. 

- Approved –
   

          an indication that the information that was submitted has been 

validated, approved, and the table locked by the system administrator.  To edit 

approved data, contact the System Administrator to unlock the table. 

- In Progress –  an indication that although information has been entered and 

saved, it has not yet been submitted. 

- Awaiting Approval –   an indication that information has been submitted, awaits 

approval, and that the table has been locked by the system administrator.  To edit data 

awaiting approval, contact the System Administrator to unlock the table. 

- Rejected (Errors Present) –   an indication that the information contained 

within the table submitted was rejected by the system administrator and, subsequently, 

an email was automatically generated and sent to the state administrator notifying 

him/her of such. 

6.1.2 Table “Action” Options 

Several actions may be performed on table data.  Action options are available based on 

table status, as defined in Section 4.1.1,    Table Status Indicators above.  (Circled in 

Figure 10). 
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Figure 10.  Table Action Options 

The following screenshot (Figure 11) is the general interface for financial tables. 

 

Figure 11. General User Interface for Financial Tables 

 

 

 



U.S. Department of Education  July 8, 2014 

OVAE NRS v14.0 – State User Guide  17  

An electronic signature is required for all FFR reports. The reports will be signed by a State 

User or State Administrator. The “Provide Electronic Signature” button will be available 

only to State Users and State Administrators. 

 

 

Figure 12a. Provide Electronic Signature 

 

Figure 13b. NRS Electronic Signature Form 
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Figure 14c. General User Interface for Financial Tables (FFR) 

Table action options include the following: 

- Edit – Allows the user to edit table data.  When editing table data, no commas or "$" 

symbols may be entered.  For values that equate to Not Applicable or None, a zero 

MUST be entered into the field – no field may be left blank.  Data should be saved 

periodically.  In particular, data MUST be saved before accessing other header tabs, 

and in instances where your system is expected to remain idle for longer than twenty 

minutes.  Failure to save your data will result in a loss of your edits.  Clicking the 

Submit button commits the data for approval by the system administrator. 
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In the event of a Warnings Present message, data may be saved, but NOT submitted.  

The data should be edited to address the specific warnings.  Upon completion, clicking 

the Submit button commits the data for approval by the system administrator.   

In the event of an ERROR message, data may NOT be saved nor submitted.  The data 

should be checked for accuracy, and corrections to errors found should be made.  

Failure to correct errors before leaving the page will result in a loss of data/input. 

The Edit Table option is NOT available when a table’s status is Awaiting Approval or 

Approved.  At this point, the table is “locked”.  To have a table “unlocked” for editing, 

contact the System Administrator. 

Note that when a user is editing a table for a particular state and year, the system will 

NOT prevent any other user (State User or State Administrator) from editing that table. 

If a user is unable to edit data because it is locked, the system will display a message 

(Figure 12) indicating that another user is editing the table and to try again later. To 

have a table “unlocked” for editing, click on the Unlock This Table button. 

 

 

Figure 15. Table Lock Message 

- Upload – Allows the user to upload a comma separated values (CSV) file containing 

table data, to be submitted for subsequent approval and commission to the data 

repository.   The required format for the CSV file is very specific and must be followed 

to the letter.  See Section 6.2, Financial Table Data Upload Instructions and File 

Format Example for instructions on how to create a CSV file and for file format 

examples. 

From the Upload Table interface, enter the file path and name in the field labeled File:; 

or click on the Browse button to locate the CSV file on your computer.  Once the file 

path and name has been inserted onto the interface, click the Upload button to upload 

the table data.  NOTE:  Regardless of the year that the user interface is set on, the table 

data will be uploaded to the year specified in the CSV upload file. 

At this point, you will be redirected to the Edit Table interface, where you must check 

the data for accuracy, make any changes, and/or correct any errors found.  Clicking the 

Submit button commits the data for approval by the system administrator.  Remember, 

when editing table data, no commas or "$" symbols may be entered.  For values that 

equate to Not Applicable or None, a zero MUST be entered into the field – No field 

may be left blank. 

 Also, data should be saved periodically.  In particular, data MUST be saved before 

accessing other header tabs and in the case where your system is expected to remain 

idle for longer than twenty minutes. Failure to save your data will result in a loss of 

your edits.    
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 Note that when a user is uploading data to a table for a particular state and year, the 

system will prevent any other user from uploading data to that table until the first user 

has finished uploading. If a user is unable to upload data because it is locked, the 

system will display a message indicating that another user is editing the table and to try 

again later. To have a table “unlocked” for uploading, contact the System 

Administrator. 

*Note:  There will be no uploads allowed for: 

               1. Final FSR for Program Year 2011 

               2. Initial FSR for Program Year 2012 and beyond 

               3. All FFRs  

 

- View* – Allows the user the single option of viewing the data. 

- Print*– Allows the user to output data to the screen at which time the user can then 

choose File, Print from their browser menu to output the data to a connected printer.  

Note:  Printer properties may, or may not, need to be adjusted to “landscape” when 

printing. 

  

*Note:  To protect the confidentiality of U.S. Department of Education data and tabulations 

containing information about individuals, while viewing or printing OVAE NRS data, table 

and report values (with the exception of monetary figures and percentages) from 1 to 5 will 

be suppressed and indicated by a “+”.  Also, the value of the total of any column or row will 

be suppressed if the column or row contains a suppressed value. 
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6.2 Financial Table Data Upload Instructions and File Format 
Example 

*Note:  There will be no uploads allowed for: 

               1. Final FSR for Program Year 2011 

               2. Initial FSR for Program Year 2012 and beyond 

               3. All FFRs  

 

Unlike the Statistical Data tables, where the users must create their own custom comma-separated 

value (CSV) files by hand, the CSV files for the Financial Status Report (FSR) tables are created 

directly from official spreadsheets provided to the states by DAEL. This dissimilarity in the 

financial data upload process is due to the complexity of the report, and the fact that all states are 

required by OVAE to use these specific spreadsheets. 

All development and testing of the FSR uploading capabilities were performed using authentic 

original spreadsheets opened in Microsoft Excel in a windows environment. We cannot 

guarantee the results using a different operating system or spreadsheet package. If the user has 

altered the FSR spreadsheets in any manner other than to enter data into the appropriate cells, 

there is a high likelihood that the upload process will fail, as such alterations will affect the data 

during the Excel to CSV conversion process. 

To create the CSV file, open the spreadsheet in Microsoft Excel. If you have multiple reports on 

different tabs, you will have to save each tab separately into its own CSV file. Select the File 

option from the menu, then choose Save As.  In the window that opens, change the file type to 

“CSV (comma-delimited) then click the “Save” button. You may be asked a confirmation 

question, stating that you will lose formatting by saving in this format. Choose to continue saving 

in CSV format despite the warning when prompted to. Please refer to the screenshot below as a 

guide. 

Once saved, you do not need to alter the CSV file in any way. 
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Figure 16. Sample Data Upload Spreadsheet 

 

After the CSV files have been created, log in to the OVAE application, select Financial section, 

then select the desired table for upload. Click on the Upload tab located at the top of the page, and 

you will be directed to the upload process interface. 

On this form selections must be made for the following items: 

         The file to be uploaded. Click the Browse button and you will be taken to a list of the 

files on your computer. Locate the CSV file and double-click on it. This will 

automatically fill in the File field. Do not alter the value in this field manually. 

         From the drop-down listing, select the FSR Table to which you are uploading. Ensure 

that you have made the correct selection; otherwise the data will be uploaded into the 

incorrect table. 

         Select the Program Year for this report. Selecting the incorrect year will cause the data to 

be incorrectly assigned in the database. 

Please see the image below for a screenshot of the upload interface. 
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Figure 17. OVAE NRS Table Upload Interface 

Click the Upload button when you are finished, and your data will be processed. If you submitted 

a valid CSV file, the data will be captured and you will be immediately taken to the Edit form 

associated with the uploaded data. Here you must review the data to ensure it was uploaded 

properly and submit it for error checking. If your CSV file was not in the expected format, or you 

failed to select values for one or more of the items on the upload interface, relevant error 

messages will be displayed. 

Please note that, due to the format of the questions on the spreadsheet, we cannot upload the 

answers for sections 6 (Final Report), 7 (Basis) and 11a (Indirect Rate Type). You will have to 

manually enter these values via the Edit Table page. We apologize for the inconvenience in this 

matter. 

7 VIEWING DOCUMENTS DATA 

7.1 Data Selection Criteria 

The selection criteria required for the viewing of documents data (see Error! Reference source 

not found.) includes the selection of a: 

 State 

 Program Year 

 

Documents data can be viewed by choosing values for the data selection criteria, then clicking the 

Go button. 
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Note: The Report Title section (see Figure 15) will always display narrative report data retrieved from the 

PREVIOUS data selection criteria process as opposed to choosing values for the data selection criteria 

and then clicking the Go button. 

 

 

 

Figure 18. Documents page 

7.2 Search Documents 

You can search documents by keyword, state, program year, and document type.  As shown in 

Figure 19 you have the option of entering a keyword, and selecting a state, program year, and 

document type to search. Once you have selected the search criteria, select the Go! button to see 

the results. 

Document types: 

a. Narrative report  

b. Assessment Policy 

c. State Plan 

d. Assurances 

e. Signed Reports – Initial 

f. Signed Reports – Final 

 

 

Figure 19. Documents search criteria 
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8 MANIPULATING DOCUMENTS DATA 

 

Within the OVAE NRS Header lies a Tabs Menu (see Error! Reference source not found.) for use in 

viewing narrative report data.   

8.1 Documents Tab 

Clicking on the Documents tab will allow the user to view documents data.  A listing is provided 

for user selection. 

8.1.1 Documents Status Indicators 

A color-coded indicator is used to indicate the current status of all narrative reports 

included in the listing.  

- Reviewed –
   

          an indication that the information that was submitted has been 

validated, approved, and the table locked by the system administrator.   

- Awaiting Review–   an indication that information has been submitted, awaits 

approval, and that the table has been locked by the system administrator.   

8.1.2 Document “Action” Options 

A couple of actions may be performed on narrative report data.  Action options are 

available based on table status, as defined in Section 8.1.1, Documents Status Indicators 

above.  (Circled inFigure 20). 

 

 

Figure 20. Documents Action Options 

 

 

  Figure 21. Documents Action Options 

Table action options include the following: 

i. Report Title Link – Allows the user the single option of viewing the data. 
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ii. Upload New Documents – Allows the user to upload a DOC, DOCX or PDF file 

to be submitted for subsequent approval and commission to the data repository.  

 

From the Upload Documents interface (see Figure 18a), enter the file path and name in 

the field labeled File; or click on the Browse button to locate the DOC, DOCX or PDF 

file on your computer. Enter the title of the document, and select a document type, 

program year, and state.  Once the file path and name, title, document type, program 

year, and state have been inserted onto the interface, click the Upload button to upload 

the document data.   

Document types: 

a. Narrative report data 

b. Assessment Policy 

c. State Plan 

d. Assurances 

e. Signed Reports – Initial 

f. Signed Reports – Final 

 

 
 

Figure 22a. Upload Documents 

The Program Year will not be available if a report is uploaded for a state/program year 

/document type for which a report has already been submitted, and the report status is 

Awaiting Review or Reviewed.    

 You can return to the Documents tab at any time to view the status of your uploaded 

report. 

 

Note: Instructions on narrative report titles and files formats will be included in OVAE’s 

annual announcements. 
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9 Performance Tab 

The Performance tab will be available to users with the following roles: 

System Administrator 

State Administrator 

State User 

Federal User 

System Administrators and Federal Users will be able to view Performance Worksheet for all 

states. 

State Administrators and State Users will be able to view Performance Worksheet for the user’s 

assigned state. 

The Performance main page is comprised of two sections (Figure 18b): 

                                        Performance Worksheet 

                                        Reports 

 

Figure 23b. Performance Page 

9.1 Performance Worksheet 

The Performance Worksheets will be available starting with PY 2015-2016. 

To access a Performance Worksheet please select a Program Year and State. Click GO button 

(Figure 18c).  



U.S. Department of Education  July 8, 2014 

OVAE NRS v14.0 – State User Guide  28  

 

Figure 24c. Performance Worksheet 

The Performance Worksheet will display National Average, Actual Performance, Target, and 

Proposed/Agreed Upon data for eleven Educational Functioning Levels and  four Core Follow Up 

Outcome measures. 

The Performance Worksheet will have three statuses: 

                                         In Progress 

                                         Submitted by State 

                                         Final Agreed Upon 

The Performance Worksheet requires first an e-sign from State Administrator or State User. The 

System Administrator or Federal User will be able to e-sign the Performance Worksheet when the 

worksheet is agreed upon and signed by State Admin or State User. 

9.2 Reports 

The Reports section of the Performance page will allow users to generate the following reports 

(Figure 18d): 

                                                   Incentive Award Eligibility Report 

Performance History Report 
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Performance Target Report (Alphabetical) 

Performance Target Report (Quartile) 

 

 

Figure 25d. Reports 

9.2.1 Performance History Report 

 The System Administrators and Federal Users can generate this report for any state. 

The State Administrators and State Users can only generate this report for their assigned state 

(Figure 18e).  

 

Figure 26e. Performance History Report Selection 
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To generate Performance History Report select: 

Report 

State (System Administrators and Federal Users) 

Report Format  

Click GO button.   

The report will be generated in an Excel file (Figure 18f) that can be opened and saved from the 

browser. 

The Performance History Report will display on each tab a data table for each Educational 

Functioning Level and Core Follow Up Measures. 

 

Figure 27f. Performance History Report 
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9.2.2 Performance Target Reports  

  The System Administrators, Federal Users, State Administrators and State Users can generate      

this report (Figure 18g). 

 

Figure 28g. Performance Target Report Selection 

To generate Performance Target Report select: 

Report 

Report Format 

Click GO button. 

The report will be generated in an Excel file (Figure 18h) that can be opened and saved from the 

browser. The Performance Target Report will display on each tab a data table for each Educational 

Functioning Level and Core Follow Up Measures. 

 

Figure 29h. Performance Target Report (Alphabetical) 
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Figure 308i. Performance Target Report (Quartile) 

For the Alphabetical Report, the system will display the data tables in alphabetical order by State’s 

two letter abbreviation. 

For the Quartile Report, the system will sort the data tables based on the values in the Target 

column (for which the targets are being negotiated) in descending order. 

9.2.3 Incentive Award Report 

The System Administrators and Federal Users can generate this report. 

 

Figure 31j. Incentive Award Eligibility Report Selection 

To generate Incentive Award Eligibility Report select: 

Report 
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Report Format 

Click GO button. 

The report will be generated in an Excel file (Figure 18k) that can be opened and saved from the 

browser.  

 

Figure 32k. Incentive Award Eligibility Report 

The Incentive Award Eligibility Report will be generated for the most recent year for which the 

state has submitted performance data. Each tab in the Excel file will displays a data table for each 

of the 50 states, District of Columbia, and Puerto Rico. 

 

 

10 Reports Tab 

The Reports tab encompasses a wide array of reports that can be output based on an assortment of 

selection criteria run against the data stored within the repository. 

There are five (5) categories of reports that can be generated within the OVAE NRS application: 

 Aggregate Table Reports 

 Static Reports 

 Ad Hoc Reports: Longitudinal 

Ad Hoc Reports:  Enrollment Data 

 Ad Hoc Reports:  Educational Gains Data 
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Clicking on the Reports tab will provide the user a listing of report interfaces to be used in 

generating OVAE NRS reports. 

10.1 Aggregate Table Reports 

The Aggregate Table Report (Figure 33) option allows the user to generate reports based on 

a combination of criteria, including the selection of: 

 A table from a listing of fixed aggregate data tables; 

 A specific Region or across All Regions.  See Appendix C for a Regions listing; 

 A defined time period determined by the selection of a Program Year start and a 

Program Year end. 

 

 

Figure 33. Aggregate Table Reports Interface 

  

Using the drop-down menus, choose the values to be used as selection criteria for your 

report.  You may clear your selections and start over at any time by clicking the Reset 

button. 

Clicking the Submit button will generate the report and output it to the screen.  At this 

point, you have three (3) options: 

 Print the report by choosing File, Print from your browser menu to output the data to a 

connected printer, or 

 Click the Export to Excel button, which will convert the data to a Microsoft Excel 

spreadsheet, launch Microsoft Excel and output the data to the screen.  The data can 

then be edited, manipulated, and/or printed, or 

 Click the Back button to go back to the previous menu of report options. 

Note:  Printer properties may, or may not, need to be adjusted to “landscape” when 

printing. 

10.2 Static Reports 

The Static Report (Figure 34) option allows the user to generate reports based on a 

combination of criteria, including the selection of: 
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 A table from a listing of tables, each created based on a single dataset using data stored 

within the repository; 

 A specific Region, multiple regions, or across All Regions.  See Appendix C for a 

Regions Listing. Or a specific state, multiple states, or across All States; 

 A defined time period determined by the selection of a Program Year start and a 

Program Year end. 

 

 

Figure 34. Static Reports Interface 

 

Using the drop-down menus, choose the values to be used as selection criteria for your 

report.  You may clear your selections and start over at any time by clicking the Reset 

button. 

Clicking the Submit button will generate the report and output it to the screen.  At this point 

you have three (3) options: 

 Print the report by choosing File, Print from your browser menu to output the data to a 

connected printer, or 

 Click the Export to Excel button, which will convert the data to a Microsoft Excel 

spreadsheet, launch Microsoft Excel and output the data to the screen.  The data can 

then be edited, manipulated, and/or printed, or 

 Click the Back button to go back to the previous menu of report options. 

Note:  Printer properties may, or may not, need to be adjusted to “landscape” when 

printing. 
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10.3 Ad Hoc Reports:  Longitudinal 

The Ad Hoc Reports (Figure 35) option allows the user to generate reports on Longitudinal 

Data based on criteria selected in an ad hoc fashion, including the selection of one of the 

following reports: 

1. Enrollment by Race/Ethnicity and Educational Functioning Level 

2. Enrollment by Age Cohort and Educational Functioning Level 

3. Number of Participants Achieving Goal of Obtaining a GED or Secondary School 

Diploma 

4. Total Numbers of Full-time Local Teachers, Counselors and Paraprofessionals 

5. Number of Participants Achieving Goal of Entering Postsecondary Education or 

Training 

6. Total Numbers of Part-time Local Teachers, Counselors and Paraprofessionals 

7. Number and Percent of Students Who Enter Employment, By Year 

8. Number and Percent of Students Who Retained Employment, By Year 

9. Number of Students Completing One or More Levels in ABE, ASE and ESL 

10. Number of Students Employed, Unemployed, or not in the Labor Force: Status by 

Year 

11.  Number of Students Employed, Unemployed, or not in the Labor Force: Status 

Percentages by Year 

12. Number of Students Employed, Unemployed, or not in the Labor Force: Status 

Numbers by Year 

You can further define your report by selecting from the following criteria: 

 A defined time period determined by the selection of a Program Year start and a 

Program Year end; 

 An Age Group or a Race/Ethnicity (may only choose one or the other) 

 A specific state, multiple states, or a National report; 
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Figure 35. Ad Hoc Reports:  Longitudinal 

Using the drop-down menus, choose the values to be used as selection criteria for your 

report.  You may clear your selections and start over at any time by clicking the Reset 

button. 

If you select report 3, 4, 5,  6, 7, 8, 9, 10, 11 or 12 the Age Group and the Race/Ethnicity 

dropdown lists will be disabled. 

Clicking the Submit button will generate the report and output it to the screen.  At this point 

you have three (3) options: 

 Print the report by choosing File, Print from your browser menu to output the data to a 

connected printer, or 

 Clicking the Export to Excel button, which will convert the data to a Microsoft Excel 

spreadsheet, launch Microsoft Excel and output the data to the screen.  The data can 

then be edited, manipulated, and/or printed, or 

 Click the Back button to go back to the previous menu of report options. 

Note:  Printer properties may, or may not, need to be adjusted to “landscape” when 

printing. 

10.4 Ad Hoc Reports:  Enrollment Data 

The Ad Hoc Reports (Figure 36) option allows the user to generate reports on Enrollment 

Data based on criteria selected in an ad hoc fashion, including the selection of: 

 A defined time period determined by the selection of a Program Year start and a 

Program Year end; 
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 A specific Region, multiple regions, or across All Regions.  See Appendix C for a 

Regions Listing. Or a specific state, multiple states, or across All States;   

 Program Type – determined by the selection of options listed under either “Overall” or 

“Detail”. Selecting a Program Type under “Overall” generates a report that displays the 

Total State Enrollment for that Program Type for the selected year(s) and state(s) or 

region(s). Selecting a Program Type under “Detail” generates a report that displays the 

Total State Enrollment for each functioning level of the selected Program Type as well 

as the Total State Enrollment for that Program Type for the selected year(s) and state(s) 

or region(s); 

 A Report Type – a total of six (6) different reports on enrollment data may be generated 

using the Ad Hoc Reports option.  See Appendix B to access detailed instructions on 

choosing selection criteria.  The report options on Enrollment Data are as follows: 

- by Detailed Total State Enrollment, 

- by Detailed Total State Enrollment (based on ethnicity), 

- by Total State Enrollment (based on ethnicity), 

- by Total State Enrollment, 

- by Total State Enrollment (based on age), 

- by Total State Enrollment (based on ethnicity and age). 

 

 

Figure 36. Ad Hoc Reports:  Enrollment Data Interface 

 

Using the drop-down menus, choose the values to be used as selection criteria for your 

report.  You may clear your selections and start over at any time by clicking the Reset 

button. 
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Clicking the Submit button will generate the report and output it to the screen.  At this point 

you have three (3) options: 

 Print the report by choosing File, Print from your browser menu to output the data to a 

connected printer, or 

 Click the Export to Excel button, which will convert the data to a Microsoft Excel 

spreadsheet, launch Microsoft Excel and output the data to the screen.  The data can 

then be edited, manipulated, and/or printed, or 

 Click the Back button to go back to the previous menu of report options. 

Note:  Printer properties may, or may not, need to be adjusted to “landscape” when 

printing. 

10.5 Ad Hoc Reports:  Educational Gains Data 

The Ad Hoc Reports (Figure 37) option allows the user to generate reports on Educational 

Gains Data based on criteria selected in an ad hoc fashion, including the selection of: 

 A defined time period determined by the selection of a Program Year start and a 

Program Year end; 

 A specific Region, multiple regions, or across All Regions.  See Appendix C for a 

Regions Listing. Or a specific state, multiple states, or across All States; 

 A Functioning Level.  

 

 
 

Figure 37. Ad Hoc Reports:  Educational Gains Data 
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Using the drop-down menus, choose the values to be used as selection criteria for your 

report.  You may clear your selections and start over at any time by clicking the Reset 

button. 

Clicking the Submit button will generate the report and output it to the screen.  At this point 

you have three (3) options: 

 Print the report by choosing File, Print from your browser menu to output the data to a 

connected printer, or 

 Click the Export to Excel button, which will convert the data to a Microsoft Excel 

spreadsheet, launch Microsoft Excel and output the data to the screen.  The data can 

then be edited, manipulated, and/or printed, or 

 Click the Back button to go back to the previous menu of report options. 

Note:  Printer properties may, or may not, need to be adjusted to “landscape” when 

printing. 
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11 NRS State Data Quality Checklist 

State users can access the online version of the State Data Quality Checklist from the main NRS home 

page. They can enter information for any state, print the latest submitted version of the checklist for any 

state, and view statistics for all checklists submitted. 

11.1  Complete the NRS State Data Quality Checklist  

To complete the State Data Quality Checklist, go to the NRS home page and select the “Complete the 

NRS State Data Quality Checklist” link. 

The system displays the state and program year in parentheses. If you need to complete the checklist for a 

different state and/or program year, please click on the “Statistical section”, select a different state and/or 

program year, and return to the NRS home page where you will see the new state and program year 

shown in parentheses.  

 

 

Figure 38. NRS Main Page with links to checklist

Once you select the “Complete the NRS State Data Quality Checklist” link, the system will display the 

online version of the checklist. 
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Figure 39. Checklist data entry page 

There are five points to note regarding this checklist form. 

 None of the questions in the checklist are required.  

 You cannot change the state; it is the state that was selected in the Statistical section of NRS. 

 You should use the “Save” button at the bottom of the page at least every 25 minutes to save your 

responses. After 30 minutes of inactivity, your session will time out and your answers will be lost 

and need to be re-entered. 

 If you have JavaScript enabled, the form will automatically save every 25 minutes. 

 After completing and submitting a survey, you can go back and add or change answers at any 

time. The last checklist submitted will be the one used by OVAE. 

11.2  Printing a Submitted State Data Quality Checklist  

State Users may print out a submitted checklist for a state by selecting the “Print your completed NRS 

State Data Quality Checklist” link from the NRS main page.  
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Figure 40. Print Your Completed Checklist 

As with the link for completing the checklist, the state code and program year displayed in parentheses is 

the state checklist you will print. If you need to work with a different state and/or program year, click on 

the “Statistical section”, select a different state and/or program year, and return to the NRS home page 

where you will see the new state code and program year shown in parentheses.  

After selecting this link, the system displays a page with a copy of the submitted checklist. Any questions 

that are missing answers will have “No answer provided.” listed for it. 

The printable checklist will also contain the NRS Data Quality Checklist Certification section at the end 

of it, which you must sign manually and submit to OVAE. 



Department of Education  July 8, 2014  October 16, 2009 

OVAE NRS v14.0 – State User Guide                                                                                                                                               44    44     44 

 
Figure 41. Printable completed checklist 
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APPENDIX A:  Statistical Table Data Upload Instructions  

This document contains CSV file format examples for each table listed on the OVAE NRS website.  In order to take advantage of the Upload 
feature, each CSV file containing table data to be submitted to the repository must follow the required file format, explicitly.  For accurate 
processing, file formats must be followed to the letter.  No variation in placements of rows or columns can occur. 

Following is a diagram of a sample CSV file, along with a key and description of what each line in the file represents: 

  

  

 

 

 

 

 

 

 

Lines 1 through 3: These three lines are to fill values for fields consistent throughout each table.  Line 1 represents the table number. Line 2 
represents the year for which the data is being submitted.  Line 3 represents the two-letter code corresponding to the 
state for which table data is being submitted. 

Line 4: Represents the column headers required for this particular table.  Header names cannot be altered.  Additional header 
names may not be added. 

Lines 5 and beyond: These lines represent the actual table data to be submitted.  For each line of table data, the first value represents the 
identifying description field for the remaining data included in that specific line/row.  NOTE: For values that equate to Not 
Applicable or None, a zero MUST be entered into the field – No field may be left blank.    

6 
2004 
DC 

Type,Number 
PSEP Disabled,100 
PSEP Employed,200 
PSEP Unemployed,300 

PSEP Not in the Labor Force,400 
PSEP On Public Assistance,500 

Line 1 

Line 2 

Line 3 

Line 4 

Line 5 
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How to Create a CSV File  

Following are instructions on how to create a CSV file from various applications including, Microsoft Excel, Microsoft Access, and Microsoft SQL 
Server.  NOTE:  Users of UNIX systems would follow these exact same instructions, as these applications work on UNIX systems identical to the 
way they work on Windows systems. 

 

From Microsoft Excel 

1. Using the examples provided below for each table as a guide, input the data into Excel so that it looks the same (minus the commas – let each 
comma represent a new cell).  For Line 4 and beyond, the number of columns will always be the same. 

 Ex:   Table 14, Line 4: Provider Agency,Total Number of Providers,Total Number of Sub-Recipients,WIA Funding Total,State Funding 

   

 

 

 

 

2. Once you have completed entering data into Excel, click on File, then Save As.  A window appears, give your document a name, and in the 
File Type listing, choose CSV (comma delimited) (*.CSV) 

3. After saving the file, close it in Excel and open it up in a text editor program, e.g., Notepad, WordPad.  Do a check to ensure the following: 

a. If a field value has a comma in it, enclose that value in quotes, e.g. “example, to use” 

b. All other fields should have no quotes, in particular, those containing numeric data. 

4. After any changes, save the file again.  You should now be ready to upload. 

NOTE: If you receive errors during the upload, go back and check your data, using the examples as a guideline.  Make sure that you have 
followed all of the rules.  Remember, the CSV files must match the example formats explicitly.  Any deviations in the location of data 
(differing columns or rows) will result in a failed upload.  In which case, you will have to repeat the Upload process with a correctly-
formatted CSV file or manually enter the data via the OVAE NRS website. 

MS Excel: 
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From Microsoft Access 

1. Before exporting data from Access, check to ensure that you can pull up your data using a single query, for each table.  Make the query 
column names the same as listed in Line 4 of each example file.  This makes the exporting process a lot easier, and the remaining instructions 
are based on you doing just that. 

 Ex:   Table 14, Line 4: Provider Agency,Total Number of Providers,Total Number of Sub-Recipients,WIA Funding Total,State Funding 

   

 

 

 

 

 

2. Once you have completed running the query, with the query results in the background, click on File, then Export.  A window appears; in the 
File Type listing choose Text Files; give your document a name with a CSV extension; click Save. 

3. The Export Text wizard appears.  Select Delimited format; then click Next. 

4. Select comma as your delimiter; check the box Include field names on first row.  Click Finish to save the file. 

5. Open the file in a text editor program, e.g., Notepad, WordPad. 

6. Manually add in Lines 1 through 3, as in the file format example.  Remember, Line 1 is the table number.  Line 2 is the year for which you are 
entering data.  Line 3 is the two-letter state abbreviation.  

7. Check the data to ensure the following: 

a. If a field value has a comma in it, enclose that value in quotes, e.g. “example, to use” 

b. All other fields should have no quotes, in particular, those containing numeric data. 

8. After any changes, save the file again.  You should now be ready to upload. 

NOTE: If you receive errors during the upload, go back and check your data, using the examples as a guideline.  Make sure that you have 
followed all of the rules.  Remember, the CSV files must match the example formats explicitly.  Any deviations in the location of data 
(differing columns or rows) will result in a failed upload.  In which case, you will have to repeat the Upload process with a correctly-
formatted CSV file or manually enter the data via the OVAE NRS website. 

MS Access: 
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From Microsoft SQL Server 

1. Before exporting data from SQL Server, check to ensure that you can pull up your data, in a single separate table, for each table upload. 
Check the following: 

a. Make the table column names the same as listed in Line 4 of each example file. 

b. Make sure the data is in the correct order, row-wise. 

c. Make sure numeric fields are created as such, and not character or text fields. 

d. Make sure that no fields contain a comma. 

This makes the exporting process a lot easier, and the remaining instructions are based on you doing just that. 

2. Create a blank text file for each table.  Right click on the table in SQL Enterprise Manager and select All Tasks, Export Data. 

3. Click the Next button twice. 

4. Select Text File for the destination; click Next. 

5. Select Copy Table(s) and View(s) from source database; click Next.  Select your created table as the source. 

6. Make sure the Delimited option is selected.  Check the box next to First row has column names. 

7. Make sure file type is ANSI; row delimiter is CR/LF; column delimiter is comma; and text qualifier is None. 

8. Click Next twice; then click Finish. 

9. Open the CSV file in a text editor, e.g., Notepad, WordPad. 

10. Manually add in Lines 1 through 3, as in the file format example.  Remember, Line 1 is the table number.  Line 2 is the year for which you are 
entering data.  Line 3 is the two-letter state abbreviation.  

11. Check the data to ensure the following: 

a. If a field value has a comma in it, enclose that value in quotes, e.g. “example, to use” 

b. All other fields should have no quotes, in particular, those containing numeric data. 

12. After any changes, save the file again.  You should now be ready to upload. 

NOTE: If you receive errors during the upload, go back and check your data, using the examples as a guideline.  Make sure that you have 
followed all of the rules.  Remember, the CSV files must match the example formats explicitly.  Any deviations in the location of data 
(differing columns or rows) will result in a failed upload.  In which case, you will have to repeat the Upload process with a correctly-
formatted CSV file or manually enter the data via the OVAE NRS website. 
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File Format Examples 

 

Table 1 - Participants by Entering Educational Functioning Level, Ethnicity, and Sex 

For the years 2006 and beyond, use the below format for this table. Please note the differences in the row headings for the ABE/ASE/ESL 
Program types. 

1,,,,,,,,,,,,,, 

2010,,,,,,,,,,,,,, 

DC,,,,,,,,,,,,,, 

Entering Educational Functioning Level,American Indian or Alaskan Native Male,American Indian or 

Alaskan Native Female,Asian Male,Asian Female,Black or African American Male,Black or African 

American Female,Hispanic or Latino Male,Hispanic or Latino Female,Native Hawaiian or Other 

Pacific Islander Male,Native Hawaiian or Other Pacific Islander Female,White Male,White 

Female,Two or More Races Male,Two or More Races Female 

ABE Beginning Literacy,1,2,3,4,5,6,7,8,9,10,11,12,0,0 

ABE Beginning Basic Education,12,11,10,9,8,7,6,5,4,3,2,1,0,0 

ABE Intermediate Low,0,1,2,3,4,5,6,7,8,9,10,11,0,0 

ABE Intermediate High,11,10,9,8,7,6,5,4,3,2,1,0,0,0 

ASE Low,11,12,13,14,15,16,17,18,19,20,21,22,0,0 

ASE High,22,21,20,19,18,17,16,15,14,13,12,11,0,0 

ESL Beginning Literacy,10,11,12,13,14,15,16,17,18,19,20,21,0,0 

ESL Beginning Low,21,20,19,18,17,16,15,14,13,12,11,10,0,0 

ESL Beginning High,21,22,23,24,25,26,27,28,29,30,31,32,0,0 

ESL Intermediate Low,32,31,30,29,28,27,26,25,24,23,22,21,0,0 

ESL Intermediate High,20,21,22,23,24,25,26,27,28,29,30,31,0,0 

ESL Advanced,31,30,29,28,27,26,25,24,23,22,21,20,0,0 

 

For the years 1997-2005, use the below format for this table. Please note the differences in the row headings for the ABE/ASE/ESL Program 
types. 

1,,,,,,,,,,,,,, 

2004,,,,,,,,,,,,,, 

DC,,,,,,,,,,,,,, 

Entering Educational Functioning Level,American Indian or Alaskan Native Male,American Indian or 
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Alaskan Native Female,Asian Male,Asian Female,Black or African American Male,Black or African 

American Female,Hispanic or Latino Male,Hispanic or Latino Female,Native Hawaiian or Other 

Pacific Islander Male,Native Hawaiian or Other Pacific Islander Female,White Male,White 

Female,Two or More Races Male,Two or More Races Female 

ABE Beginning Literacy,1,2,3,4,5,6,7,8,9,10,11,12,0,0 

ABE Beginning Basic Education,12,11,10,9,8,7,6,5,4,3,2,1,0,0 

ABE Intermediate Low,0,1,2,3,4,5,6,7,8,9,10,11,0,0 

ABE Intermediate High,11,10,9,8,7,6,5,4,3,2,1,0,0,0 

ASE Low,11,12,13,14,15,16,17,18,19,20,21,22,0,0 

ASE High,22,21,20,19,18,17,16,15,14,13,12,11,0,0 

ESL Beginning Literacy,10,11,12,13,14,15,16,17,18,19,20,21,0,0 

ESL Beginning,21,20,19,18,17,16,15,14,13,12,11,10,0,0 

ESL Intermediate Low,21,22,23,24,25,26,27,28,29,30,31,32,0,0 

ESL Intermediate High,32,31,30,29,28,27,26,25,24,23,22,21,0,0 

ESL Low Advanced,20,21,22,23,24,25,26,27,28,29,30,31,0,0 

ESL High Advanced,31,30,29,28,27,26,25,24,23,22,21,20,0,0 

 

Table 2  - Participants by Age, Ethnicity, and Sex 

2,,,,,,,,,,,,,, 

2010,,,,,,,,,,,,,, 

DC,,,,,,,,,,,,,, 

Age Group,American Indian or Alaskan Native Male,American Indian or Alaskan Native Female,Asian 

Male,Asian Female,Black or African American Male,Black or African American Female,Hispanic or 

Latino Male,Hispanic or Latino Female,Native Hawaiian or Other Pacific Islander Male,Native 

Hawaiian or Other Pacific Islander Female,White Male,White Female,Two or More Races Male,Two or 

More Races Female 

16-18,1,2,3,4,5,6,7,8,9,10,11,12,0,0 

19-24,12,11,10,9,8,7,6,5,4,3,2,1,0,0 

25-44,0,1,2,3,4,5,6,7,8,9,10,11,0,0 

45-59,11,10,9,8,7,6,5,4,3,2,1,0,0,0 

60 and Older,11,12,13,14,15,16,17,18,19,20,21,22,0,0 
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Table 3 - Participants by Program Type and Age 

3,,,,, 

2010,,,,, 

DC,,,,, 

Program Type,16-18,19-24,25-44,45-59,60+ 

Adult Basic Education (ABE),10,20,30,40,50 

Adult Secondary Education (ASE),50,40,30,20,10 

English-as-a-Second Language (ESL),0,10,20,30,40 

 

Table 4 - Educational Gains and Attendance by Educational Functioning Level 

For the years 2006 and beyond, use the below format for this table. Please note the differences in the row headings for the ABE/ASE/ESL 
Program types. 

4,,,,, 

2010,,,,, 

DC,,,,, 

Entering Educational Functioning Level,Total Attendance Hours,Number completed Level,Number who 

completed a Level and Advanced One or More Levels,Number Separated Before Completed,Number 

Remaining within Level 

ABE Beginning Literacy,10,20,30,40,50 

ABE Beginning Basic Education,50,40,30,20,10 

ABE Intermediate Low,10,20,30,40,50 

ABE Intermediate High,50,40,30,20,10 

ASE Low,10,20,30,40,50 

ASE High,50,40,30,20,10 

ESL Beginning Literacy,10,20,30,40,50 

ESL Beginning Low,50,40,30,20,10 

ESL Beginning High,10,20,30,40,50 

ESL Intermediate Low,50,40,30,20,10 

ESL Intermediate High,10,20,30,40,50 

ESL Advanced,50,40,30,20,10 

 

For the years 1997-2005, use the below format for this table. Please note the differences in the row headings for the ABE/ASE/ESL Program 
types. 
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4,,,,, 

2004,,,,, 

DC,,,,, 

Entering Educational Functioning Level,Total Attendance Hours,Number completed Level,Number who 

completed a Level and Advanced One or More Levels,Number Separated Before Completed,Number 

Remaining within Level 

ABE Beginning Literacy,10,20,30,40,50 

ABE Beginning Basic Education,50,40,30,20,10 

ABE Intermediate Low,10,20,30,40,50 

ABE Intermediate High,50,40,30,20,10 

ASE Low,10,20,30,40,50 

ASE High,50,40,30,20,10 

ESL Beginning Literacy,10,20,30,40,50 

ESL Beginning,50,40,30,20,10 

ESL Intermediate Low,10,20,30,40,50 

ESL Intermediate High,50,40,30,20,10 

ESL Low Advanced,10,20,30,40,50 

ESL High Advanced,50,40,30,20,10 

 

Table 4a - Educational Gains and Attendance by Educational Functioning Level, with Completion Breakdown 

For the years 2006 and beyond, uploads are not allowed for this table. For the years 1997-2005, use the below format for this table. Please 
note the differences in the row headings for the ABE/ASE/ESL Program types. 

4A, 

2004, 

DC, 

Entering Educational Functioning Level,Number who completed a Level and Advanced 

ABE Beginning Literacy,100 

ABE Beginning Basic Education,200 

ABE Intermediate Low,300 

ABE Intermediate High,400 

ASE Low,500 

ASE High,600 

ESL Beginning Literacy,700 

ESL Beginning,800 

ESL Intermediate Low,900 
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ESL Intermediate High,1000 

ESL Low Advanced,1100 

ESL High Advanced,1200 

 

Table 4b - Educational Gains and Attendance for Pre- and Post-tested Participants 

For the years 2006 and beyond, use the below format for this table. Please note the differences in the row headings for the ABE/ASE/ESL 
Program types. 

4B,,,,, 

2010,,,,, 

DC,,,,, 

Entering Educational Functioning Level,Total Attendance Hours,Number Completed Level,Number who 

completed a Level and Advanced One or More Levels,Number Separated Before Completed,Number 

Remaining within Level 

ABE Beginning Literacy,10,20,30,40,50 

ABE Beginning Basic Education,50,40,30,20,10 

ABE Intermediate Low,10,20,30,40,50 

ABE Intermediate High,50,40,30,20,10 

ASE Low,10,20,30,40,50 

ASE High,50,40,30,20,10 

ESL Beginning Literacy,10,20,30,40,50 

ESL Beginning Low,50,40,30,20,10 

ESL Beginning High,10,20,30,40,50 

ESL Intermediate Low,50,40,30,20,10 

ESL Intermediate High,10,20,30,40,50 

ESL Advanced,50,40,30,20,10 

 

For the years 1997-2005, use the below format for this table. Please note the differences in the row headings for the ABE/ASE/ESL Program 
types. 

4B,,,,, 

2004,,,,, 

DC,,,,, 

Entering Educational Functioning Level,Total Attendance Hours,Number Completed Level,Number who 

completed a Level and Advanced One or More Levels,Number Separated Before Completed,Number 
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Remaining within Level 

ABE Beginning Literacy,10,20,30,40,50 

ABE Beginning Basic Education,50,40,30,20,10 

ABE Intermediate Low,10,20,30,40,50 

ABE Intermediate High,50,40,30,20,10 

ASE Low,10,20,30,40,50 

ASE High,50,40,30,20,10 

ESL Beginning Literacy,10,20,30,40,50 

ESL Beginning,50,40,30,20,10 

ESL Intermediate Low,10,20,30,40,50 

ESL Intermediate High,50,40,30,20,10 

ESL Low Advanced,10,20,30,40,50 

ESL High Advanced,50,40,30,20,10 

 

Table 4c- Educational Gains and Attendance For Participants in Distance Education 

For the years 1997-2005, uploads are not allowed for this table. For the years 2006 and beyond, use the below format for this table. Please 
note the differences in the row headings for the ABE/ASE/ESL Program types. 

4C,,,,, 

2010,,,,, 

DC,,,,, 

Entering Educational Functioning Level,Total Attendance Hours,Number completed Level,Number who 

completed a Level and Advanced One or More Levels,Number Separated Before Completed,Number 

Remaining within Level 

ABE Beginning Literacy,10,20,30,40,50 

ABE Beginning Basic Education,50,40,30,20,10 

ABE Intermediate Low,10,20,30,40,50 

ABE Intermediate High,50,40,30,20,10 

ASE Low,10,20,30,40,50 

ASE High,50,40,30,20,10 

ESL Beginning Literacy,10,20,30,40,50 

ESL Beginning Low,50,40,30,20,10 

ESL Beginning High,10,20,30,40,50 

ESL Intermediate Low,50,40,30,20,10 

ESL Intermediate High,10,20,30,40,50 

ESL Advanced,50,40,30,20,10 
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Table 5 - Core Follow-up Outcome Achievement  

For the years 2012 and later, use the below format for this table. 

5,,,,, 

2012,,,,, 

DC,,,,, 

Core Follow-up Outcome Measures,Method,Number of Participants in Cohort,Number of Participants 

Used for Representative Cohort,Number of Participants Responding to Survey or Available for Data 

Matching,Number of Participants Achieving Outcome (Unweighted) 

Entered Employment,U,20,N/A,20,20 

Entered Employment,R,30,10,30,30 

Retained Employment,U,40,N/A,40,40 

Retained Employment,R,50,20,50,50 

Obtained a GED or Secondary School Diploma,U,60,N/A,60,60 

Obtained a GED or Secondary School Diploma,R,70,30,70,70 

Entered Postsecondary Education or Training - current program year,U,80,N/A,80,80 

Entered Postsecondary Education or Training - current program year,R,90,40,90,90 

Entered Postsecondary Education or Training - prior program year,U,100,N/A,100,100 

Entered Postsecondary Education or Training - prior program year,R,110,50,110,110 

 

For the years 2011 and earlier, use the below format for this table.  

5,,,,, 

2010,,,,, 

DC,,,,, 

Core Follow-up Outcome Measures,Number of Participants with Main or Secondary Goal,Number of 

Participants Included in Survey (Sampled and Universe),Number of Participants Responding to Survey 

or Used for Data Matching,Number of Participants Achieving Outcome,Weighted Average Percent 

Achieving Outcome 

Entered Employment,10,20,30,40,50 

Retained Employment,50,40,30,20,10 

Obtained a GED or Secondary School Diploma,10,20,30,40,50 

Entered Postsecondary Education or Training,50,40,30,20,10 
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Table 5a - Core Follow-up Outcome Achievement for Participants in Distance Education 

For the years 2012 and later, use the below format for this table. 

5A,,,,,, 

2012,,,,,, 

DC,,,,,, 

Core Follow-up Outcome Measures,Method,Number of Participants in Cohort,Number of Participants Used for 

Representative Cohort,Number of Participants Responding to Survey or Available for Data Matching,Number of 

Participants Achieving Outcome (Unweighted),Percent Achieving Outcome 

Entered Employment,U,10,20,30,40,50 

Entered Employment,R,10,20,30,40,50 

Retained Employment,U,50,40,30,20,10 

Retained Employment,R,50,40,30,20,10 

Obtained a GED or Secondary School Diploma,U,10,20,30,40,50 

Obtained a GED or Secondary School Diploma,R,10,20,30,40,50 

Entered Postsecondary Education or Training - current program year,U,50,40,30,20,10 

Entered Postsecondary Education or Training - current program year,R,50,40,30,20,10 

Entered Postsecondary Education or Training - prior program year,U,50,40,30,20,10 

Entered Postsecondary Education or Training - prior program year,R,50,40,30,20,10 

 

 

 

For the years 2011 and earlier, use the below format for this table. 

5A,,,,, 

2010,,,,, 

DC,,,,, 

Core Follow-up Outcome Measures,Number of Participants with Main or Secondary Goal,Number of 

Participants Included in Survey,Number of Participants Responding to Survey or Used for Data 

Matching,Number of Participants Achieving Outcome,Percent Achieving Outcome 

Entered Employment,10,20,30,40,50 

Retained Employment,50,40,30,20,10 

Obtained a GED or Secondary School Diploma,10,20,30,40,50 

Entered Postsecondary Education or Training,50,40,30,20,10 
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Table 6 - Participant Status and Program Enrollment 

For the years 2012 and later, use the below format for this table. 

6, 

2012, 

DC, 

Type,Number 

PSEP Disabled,100 

PSEP Employed,200 

PSEP Unemployed,300 

PSEP Not in the Labor Force,400 

PSEP On Public Assistance,500 

PSEP Living in Rural Areas,600 

Highest Degree or Level of School Completed No schooling,200,800 

Highest Degree or Level of School Completed Grades 1-5,500,550 

Highest Degree or Level of School Completed Grades 6-8,350,550 

Highest Degree or Level of School Completed Grades 9-12 (no diploma),450,550 

Highest Degree or Level of School Completed High School Diploma or alternate credential,400,500 

Highest Degree or Level of School Completed GED,450,850 

Highest Degree or Level of School Completed Some college, no degree,550,650 

Highest Degree or Level of School Completed College or professional degree,700,700 

Highest Degree or Level of School Completed Unknown,300,300 

Program Type In Family Literacy Programs,700 

Program Type In Workplace Literacy Programs,800 

Program Type In Programs for the Homeless,900 

Program Type In Programs for Work-based Project Learners,1000 

Institutional Programs In Correctional Facilities,1100 

Institutional Programs In Community Correctional Programs,1200 

Institutional Programs In Other Institutional Settings,1300 

Secondary Status Measures (Optional) Low Income,1400 

Secondary Status Measures (Optional) Displaced Homemaker,1500 

Secondary Status Measures (Optional) Single Parent,1600 

Secondary Status Measures (Optional) Dislocated Worker,1700 

Secondary Status Measures (Optional) Learning Disabled Adults,1800 
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For the years 2011 and earlier, use the below format for this table. 

6, 

2010, 

DC, 

Type,Number 

PSEP Disabled,100 

PSEP Employed,200 

PSEP Unemployed,300 

PSEP Not in the Labor Force,400 

PSEP On Public Assistance,500 

PSEP Living in Rural Areas,600 

Program Type In Family Literacy Programs,700 

Program Type In Workplace Literacy Programs,800 

Program Type In Programs for the Homeless,900 

Program Type In Programs for Work-based Project Learners,1000 

Institutional Programs In Correctional Facilities,1100 

Institutional Programs In Community Correctional Programs,1200 

Institutional Programs In Other Institutional Settings,1300 

Secondary Status Measures (Optional) Low Income,1400 

Secondary Status Measures (Optional) Displaced Homemaker,1500 

Secondary Status Measures (Optional) Single Parent,1600 

Secondary Status Measures (Optional) Dislocated Worker,1700 

Secondary Status Measures (Optional) Learning Disabled Adults,1800 
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Table 7 - Adult Education Personnel by Function and Job Status 

For the years 2012 and later, use the below format for this table. 

7,,, 

2012,,, 

DC,,, 

Function,Total Number of Part-time Personnel,Total Number of Full-time Personnel,Unpaid Volunteers 

State-level Administrative/Supervisory/Ancillary Services,10,20,30 

Local-level Administrative/Supervisory/Ancillary Services,30,20,10 

Local Teachers,10,20,30 

Local Counselors,30,20,10 

Local Paraprofessionals,10,20,30 

"""Teachers' Years of Experience in Adult Education""",,, 

Less than one year,20,20, 

One to three years,40,40, 

More than three years,60,60, 

Teacher Certification,,, 

No Certification,10,10, 

Adult Education Certification,30,30, 

K-12 Certification ,50,50, 

Special Education Certification,70,70, 

TESOL Certification,90,90, 

 

 



Department of Education    July 8, 2014 

OVAE NRS v14.0 – State User Guide                                                                                                                                                   60     60 

For the years 2011 and earlier, use the below format for this table. 

7,,, 

2010,,, 

DC,,, 

Function,Total Number of Part-time Personnel,Total Number of Full-time Personnel,Unpaid Volunteers 

State-level Administrative/Supervisory/Ancillary Services,10,20,30 

Local-level Administrative/Supervisory/Ancillary Services,30,20,10 

Local Teachers,10,20,30 

Local Counselors,30,20,10 

Local Paraprofessionals,10,20,30 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Department of Education    July 8, 2014 

OVAE NRS v14.0 – State User Guide                                                                                                                                                   61     61 

Table 8 - Outcomes for Adults in Family Literacy Programs 

For the years 2012 and later, use the below format for this table. 

8,,,,, 

2012,,,,, 

DC,,,,, 

Core Follow-up Outcome Measures,Method,Number of Participants in Cohort,Number of Participants 

Used for Representative Cohort,Number of Participants Responding to Survey or Available for Data 

Matching,Number of Participants Achieving Outcome (Unweighted) 

Completed an Educational Functioning Level*,U,10,N/A,10,10 

Entered Employment,U,20,N/A,20,20 

Entered Employment,R,30,10,30,30 

Retained Employment,U,40,N/A,40,40 

Retained Employment,R,50,20,50,50 

Obtained a GED or Secondary School Diploma,U,60,N/A,60,60 

Obtained a GED or Secondary School Diploma,R,70,30,70,70 

Entered Postsecondary Education or Training - current program year,U,80,N/A,80,80 

Entered Postsecondary Education or Training - current program year,R,90,40,90,90 

Entered Postsecondary Education or Training - prior program year,U,100,N/A,100,100 

Entered Postsecondary Education or Training - prior program year,R,110,50,110,110 

Increased Involvement in Children's Education,U,120,N/A,120,120 

Increased Involvement in Children's Education,R,130,60,130,130 

Helped more frequently with school,,140,70,140,140 

Increased contact with children's teachers,,150,80,150,150 

More involved in children's school activities,,160,90,160,160 

Increased Involvement in Children's Literacy Activities,U,170,N/A,170,170 

Increased Involvement in Children's Literacy Activities,R,180,100,180,180 

Reading to children,,190,110,190,190 

Visiting library,,200,120,200,200 

Purchasing books or magazines,,210,130,210,210 
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For the years 2011 and earlier, use the below format for this table. 

8,,,,, 

2010,,,,, 

DC,,,,, 

Core Follow-up Outcome Measures,Number of Participants with Main or Secondary Goal,Number of 

Participants Included in Survey (Sampled and Universe),Number of Participants Responding to Survey 

or Used for data Matching,Response Rate or Percent available for Match,Number of Participants 

Achieving Outcome 

Completed an Educational Functioning Level,10,,,,50 

Entered Employment,50,40,30,20,10 

Retained Employment,10,20,30,40,50 

Obtained a GED or Secondary School Diploma,50,40,30,20,10 

Entered Postsecondary Education or Training,10,20,30,40,50 

Increased Involvement in children's education,50,40,30,20,10 

Helped more frequently with school,,,,,50 

Increased contact with children's teachers,,,,,10 

More involved in children's school activities,,,,,50 

Increased involvement in children's literacy activities,50,40,30,20,10 

Reading to children,,,,,50 

Visiting library,,,,,10 

Purchasing books or magazines,,,,,50 
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Table 9 - Outcomes for Adults in Workplace Literacy Programs 

For the years 2012 and later, use the below format for this table. 

9,,,,, 

2012,,,,, 

DC,,,,, 

Core Follow-up Outcome Measures,Method,Number of Participants in Cohort,Number of Participants 

Used for Representative Cohort,Number of Participants Responding to Survey or Available for Data 

Matching,Number of Participants Achieving Outcome (Unweighted) 

Completed an Educational Functioning Level*,U,10,N/A,10,10 

Entered Employment,U,20,N/A,20,20 

Entered Employment,R,30,10,30,30 

Retained Employment,U,40,N/A,40,40 

Retained Employment,R,50,20,50,50 

Obtained a GED or Secondary School Diploma,U,60,N/A,60,60 

Obtained a GED or Secondary School Diploma,R,70,30,70,70 

Entered Postsecondary Education or Training - current program year,U,80,N/A,80,80 

Entered Postsecondary Education or Training - current program year,R,90,40,90,90 

Entered Postsecondary Education or Training - prior program year,U,100,N/A,100,100 

Entered Postsecondary Education or Training - prior program year,R,110,50,110,110 
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For the years 2011 and earlier, use the below format for this table. 

9,,,,, 

2010,,,,, 

DC,,,,, 

Core Follow-up Outcome Measures,Number of Participants with Main or Secondary Goal,Number of 

Participants Included in Survey (Sampled and Universe),Number of Participants Responding to Survey 

or Used for data Matching,Response Rate or Percent available for Match,Number of Participants 

Achieving Outcome 

Completed an Educational Functioning Level,10,,,,50 

Entered Employment,50,40,30,20,10 

Retained Employment,10,20,30,40,50 

Obtained a GED or Secondary School Diploma,50,40,30,20,10 

Entered Postsecondary Education or Training,10,20,30,40,50 
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Table 10 - Outcomes for Adult Correctional Education Programs 

For the years 2012 and later, use the below format for this table. 

10 

2012 

DC 

Core Follow-up Outcome Measures,Method,Number of Participants in Cohort,Number of Participants 

Used for Representative Cohort,Number of Participants Responding to Survey or Available for Data 

Matching,Number of Participants Achieving Outcome (Unweighted) 

Completed an Educational Functioning Level*,U,10,N/A,10,10 

Entered Employment,U,20,N/A,20,20 

Entered Employment,R,30,10,30,30 

Retained Employment,U,40,N/A,40,40 

Retained Employment,R,50,20,50,50 

Obtained a GED or Secondary School Diploma,U,60,N/A,60,60 

Obtained a GED or Secondary School Diploma,R,70,30,70,70 

Entered Postsecondary Education or Training - current program year,U,80,N/A,80,80 

Entered Postsecondary Education or Training - current program year,R,90,40,90,90 

Entered Postsecondary Education or Training - prior program year,U,100,N/A,100,100 

Entered Postsecondary Education or Training - prior program year,R,110,50,110,110 

 

 

For the years 2011 and earlier, use the below format for this table. 

10,,,,, 

2010,,,,, 

DC,,,,, 

Core Follow-up Outcome Measures,Number of Participants with Main or Secondary Goal,Number of 

Participants Included in Survey (Sampled and Universe),Number of Participants Responding to Survey 

or Used for data Matching,Response Rate or Percent available for Match,Number of Participants 

Achieving Outcome 

Completed an Educational Functioning Level,10,,,,50 
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Entered Employment,50,40,30,20,10 

Retained Employment,10,20,30,40,50 

Obtained a GED or Secondary School Diploma,50,40,30,20,10 

Entered Postsecondary Education or Training,10,20,30,40,50 

 

Table 11 - Secondary Outcome Measures 

11,, 

2010,, 

DC,, 

Secondary Outcome Measures,Number of Participants with Main or Secondary Goal or Status,Number of 

Participants Obtaining Outcome 

Achieved work-based project learning goal,100,200 

Left public assistance,200,100 

Achieved citizenship skills,100,200 

Increased involvement in children's education,200,100 

Increased involvement in children's literacy activities,100,200 

Voted or registered to vote,200,100 

Increased involvement in community activities,100,200 

 

Table 12 - Work-based Project Learners by Age, Ethnicity, and Sex 

12,,,,,,,,,,,,,, 

2010,,,,,,,,,,,,,, 

DC,,,,,,,,,,,,,, 

Age Group,American Indian or Alaskan Native Male,American Indian or Alaskan Native Female,Asian 

Male,Asian Female,Black or African American Male,Black or African American Female,Hispanic or 

Latino Male,Hispanic or Latino Female,Native Hawaiian or Other Pacific Islander Male,Native 

Hawaiian or Other Pacific Islander Female,White Male,White Female,Two or More Races Male,Two or 

More Races Female 

16-18,10,20,30,40,50,60,70,80,90,100,110,120,0,0 

19-24,120,110,100,90,80,70,60,50,40,30,20,10,0,0 

25-44,10,20,30,40,50,60,70,80,90,100,110,120,0,0 

45-59,120,110,100,90,80,70,60,50,40,30,20,10,0,0 

60 and Older,10,20,30,40,50,60,70,80,90,100,110,120,0,0 
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Table 13 - Core Follow-up Outcome Achievement for Prior Reporting Year and for Unintended Outcomes 

For the Program year 2012 and later, uploads and updates are not allowed for this table. 

13,, 

2010,, 

DC,, 

Core Follow-up Outcome Measures,Number of Participants with Main or Secondary Goal Who Achieved 

Outcome but Were Not Reported in the Prior Reporting Period,Number of Participants Achieving 

Outcome in Current Year Who Did Not Have the Outcome as a Goal 

Entered Employment,10,20 

Retained Employment,20,10 

Obtained a GED or Secondary School Diploma,10,20 

Placed in postsecondary education or training,20,10 

 

Table 14 - Local Grantees by Funding Source and Number of Students 

14,,,, 

2010,,,, 

DC,,,, 

Provider Agency,Total Number of Providers,Total Number of Sub-Recipients,WIA Funding Total,State 

Funding Total 

Local Education Agencies,10,20,30,40 

Community-based Organizations,40,30,20,10 

Faith-based Organizations,10,20,30,40 

Libraries,40,30,20,10 

Community Junior or Technical Colleges,10,20,30,40 

Four-year Colleges or Universities,40,30,20,10 

Other Institutions of Higher Education,10,20,30,40 

Correctional Institutions,40,30,20,10 

Other Institutions (non-correctional),10,20,30,40 

All Other Agencies,40,30,20,10 
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APPENDIX B:  Ad Hoc Reports: Enrollment Data 
Report Types 

Listed below are six (6) report types available using OVAE NRS Enrollment Data.  To generate the 

report, values must be entered in each field listed under the Selection Criteria heading associated with 

each report.  Clicking the Submit button will generate the report and output it to the screen. 

 

Report Type Selection Criteria  

1.  Detailed Total State Enrollment  

1. Program Year (Start)  
2. Program Year (End)  
3. Region(s) or State(s)  
4. Program Type: Detail  
5. Submit  

2.  Detailed Total State Enrollment (based on ethnicity)  

1. Program Year (Start)  
2. Program Year (End) 
3. Region(s) or State(s)  
4. Program Type: Detail  
5. Check Ethnicity Group box  
6. Submit  

3.  Total State Enrollment (based on ethnicity) 

1. Program Year (Start) 
2. Program Year (End) 
3. Region(s) or State(s)  
4. Program Type: Overall  
5. Check Ethnicity Group box  
6. Submit  

4.  Total State Enrollment  

1. Program Year (Start) 
2. Program Year (End) 
3. Region(s) or State(s)  
4. Program Type: Overall  
5. Submit  

5.  Total State Enrollment (based on age)  

1. Program Year (Start) 
2. Program Year (End) 
3. Region(s) or State(s)  
4. Program Type: Overall  
5. Age Group: pick “Select All” 
6. Submit  

6.  Total State Enrollment (based on ethnicity and age)  

1. Program Year (Start) 
2. Program Year (End) 
3. Region(s) or State(s)  
4. Age Group: one of the following 

o 16-18  
o 19-24  
o 24-44  
o 45-59  
o 60 and older 

5. Check Ethnicity Group box  
6. Submit  
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APPENDIX C:  Region Listing 
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Appendix D – PDF Accessibility Tips 

You must have Adobe Acrobat 8 Professional installed to use these tips to create and edit PDF 

documents. 

Creating an Accessible Adobe PDF file from Microsoft Office 
Applications 

Enhance Accessibility of MS Word Document 

To enhance the accessibility of your MS Word documents before converting them to PDF: 

 Use styles to format your Word document, such as titles, headings and paragraphs 

 Use the Columns command in Word to create columns in lieu of tabbing 

 Use the Insert Table command or Draw Table tool in Word to create tables 

 Add alternate text to all images. To add alternate text: 

1. Right click on the image 

2. Select Format Picture 

3. Select the Web tab 

4. Type a description of the image in the Alternative Text field 

5. Select the OK button 

Convert Document to Adobe PDF 

1. Open your document in the chosen MS Office application (Word, PowerPoint, Excel).  

2. Choose Adobe PDF > Change Conversion Settings. Ensure the following settings are enabled: 

 Attach source file to Adobe PDF 

 Add Links to Adobe PDF 

 Add Bookmarks to Adobe PDF 

 Enable Accessibility and Reflow with Tagged PDF 

3. Click the OK button to close the Acrobat PDF Maker window 

4. Choose Adobe PDF > Convert to Adobe PDF 

5. Select a location at which to save the PDF, and select the Save button. The PDF will be generated 

and opened in Adobe Acrobat Professional. 
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Test PDF Document for Accessibility 

Quick Check 

To Quick Check your PDF document for accessibility: 

1. Open your PDF in Adobe Acrobat Professional 

2. Select Advanced > Accessibility > Quick Check 

Full Check 

To Full Check your PDF document for accessibility: 

1. Open your PDF in Adobe Acrobat Professional 

2. Select Advanced > Accessibility > Full Check 

 Select Create Accessibility Report, and choose a location for the report 

 Specify the pages you want included in the check 

 Select the Checking Options that you want included in the check 

 Choose the Start Checking button 

Read Out Loud 

To Full Check your PDF document for accessibility: 

1. Open your PDF in Adobe Acrobat Professional 

2. Select View > Read Out Loud and listen to Acrobat read the document to you 

If problems exist, you may need to tag some elements in your document. 

Tag PDF Document 

The tagging process is a critical step necessary to ensure your PDF is accessible to assistive technology 

such as screen readers. Tagged documents follow a logical structure that allows screen readers to navigate 

to a page, read information and interpret graphics. 

In Adobe Acrobat Professional you can tag a PDF document using the following method: 

1. Open your PDF in Adobe Acrobat Professional 

2. Choose Advanced > Accessibility > Add Tags to Document 

Depending on what elements your document contains, such as images and links, you may need to add 

additional tags to make your PDF fully accessible to screen readers such as JAWS and Window Eyes.  

Applying Tags Manually to Fix Problem Areas 

To create a tags tree for untagged PDF file: 
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1. Open your PDF in Adobe Acrobat Professional 

2. Open the Tags tab in the Navigation pane, or choose View > Navigation Tabs > Tags to open the 

Tags tab 

3. Choose Options > New Tag. Label the tag and select the OK button. 

4. Highlight the tag name 

5. On the right of the window, select Options > Properties to add alt text. Select the Close button. 

6. Save the document.   

Adding tags to already tagged PDF tree: 

1. Select the element preceding the new tag 

2. Choose Options > New Tag 

3. In the menu, choose the type of element you want to create, and enter a title. Select the OK 

button. 

4. If necessary, drag the new element to the desired position in the tags tree and then save the 

document.  

Adding Alt Text 

If your document has no descriptive text or alt text on images, the image itself will provide no 

information to a screen reader and the image is not accessible. To remedy this, add alt text: 

1. In the tags tree, find the <Link> tag 

2. Right click on the <Link> tag 

3. Select Options > Properties 

4. Enter alt text and select the Close button 

Additional Resources 

 Adobe Acrobat 8 Professional User Guide - 

http://help.adobe.com/en_US/Acrobat/8.0/Professional/help.pdf (Chapter 10) 

 Using Accessibility Features Within Acrobat 8 - 

http://www.adobe.com/enterprise/accessibility/popup_acr8_accessibility.html 

 Assessing PDF Files for Accessibility - 

http://www.adobe.com/enterprise/accessibility/popup_assess_pdfs.html 

 Creating Accessible PDF Files - 

http://www.adobe.com/enterprise/accessibility/popup_create_pdfs.html 

 

http://help.adobe.com/en_US/Acrobat/8.0/Professional/help.pdf
http://www.adobe.com/enterprise/accessibility/popup_acr8_accessibility.html
http://www.adobe.com/enterprise/accessibility/popup_assess_pdfs.html

